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The Council for the Advancement of Forensic Genealogy (CAFG) is
now accepting applications for three $225 scholarships (expanded
from one offered initally) to the 5th Annual Forensic Genealogy
Institute (FGI), to be held March 10-12, 2016, at The Menger Hotel
at the Riverwalk in San Antonio, Texas. Tuition for each course is
$445, and the scholarships cover more than 50% of that fee. The
final day to submit an application has been extended to December
12, 2015.
“The scholarships to CAFG’s Forensic Genealogy Institute are
intended to ease the financial burden of advanced, professional
education,” says Leslie Lawson, CAFG President. “The scholarships
give up-and-coming forensic/genetic genealogists the opportunity
to advance their career and increase their skills.”
FGI 2016 will be the first ever hands-on seminar offering of forensic
genealogy for intermediate and advanced genealogists. Each FGI
course offers 20 hours of instruction by expert forensic and genetic
genealogists in just three days, minimizing travel costs and time
away from family and work. Seats are limited at FGI, so early
registration is encouraged. Registration is now open at
http://www.forensicgenealogists.org/institute/.

President
Leslie Lawson
Vice President
Sheila Benedict
Treasurer
Juli Whittaker

Continued on page 2

Secretary & Newsletter
Editor
Bethany Waterbury

Inside This Issue

Membership Coordinator
Helen Haldeman Daglas

1-2
3-5
6
6

2016 FGI Scholarship Deadline Extended
Macros: Clearing up the Mystery, Part 2
Menger Hotel Information
Members in the News

Copyright 2015 Council for the Advancement of Forensic Genealogy

Forensic Genealogy News

Fall 2015

Volume 5, Issue 4

Page 2

2016 FGI Scholarship Deadline Extended,
continued
Continued from page 1

Scholarship Application Process
The FGI scholarships are open to all FGI 2016 registrants. Individuals interested in financial
assistance to attend the institute should send a request of not more than 400 words
to institute@forensicgenealogists.org explaining how they feel receiving an FGI Scholarship might
best help them and the field of forensic genealogy. Applications are due December 12, 2015. The
scholarship recipients will receive a partial tuition refund of $225.
Those wanting to apply for the scholarships but who have not yet registered for FGI can do so
online at http://www.forensicgenealogists.org/institute/ before submitting their application.

Brand-New, Advanced Training
FGI 2016 features two brand-new, concurrent courses designed for intermediate and advanced
forensic genealogists:
• Thursday all attendees will participate in:
o Marketing Workshop: Taking Charge, Blogging, and Connecting with Influencers
with Marian Pierre-Louis and;
o Professional Forensic Business Workshop with Michael S. Ramage, JD, CGSM
• Friday and Saturday attendees will be in their chosen classes:
o Forensic Genealogy Practicum or;
o Advanced DNA Practicum
The Advanced DNA Practicum will be taught by renowned genetic genealogists CeCe Moore and
Bethany Waterbury, DVM. This Advanced DNA Practicum course allows attendees to have the
opportunity to work through real-life case studies. (Prerequisites and full course details for this
class can be found at http://www.forensicgenealogists.org/institute/).
The Forensic Genealogy Practicum offers practical, real-life experience in forensic genealogy.
Students will leave the course having written a marketing plan and a contract for their business.
They will also work a real forensic case from start to finish and be introduced to genetic genealogy’s
role
in
forensic
genealogy.
Full
course
details
are
available
at http://www.forensicgenealogists.org/institute/.
Courses are expected to fill, so early registration is encouraged at https://fgi2016.eventbrite.com.
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Macros: Clearing Up the Mystery,
Part 2
By Brent Chadwick
In part 1 of this series, I explained what a macro is, what it can do, and how it can be applied to
professional genealogy work. In this article, I will explain how to “record” a simple macro that can
be used in your everyday work.
First though, we need to ensure that we can record a macro in MS Word. Open up a new document
in MS Word and observe if there is a tab in your ribbon marked “Developer.” 1 If the “Developer”
tab is not visible, follow these steps:
Macintosh
• Click on the “Gear” shaped icon at the top right-hand corner of your document.
• Select “Ribbon Preferences”, scroll down and check the “Developer” box. Click “OK”
and the “Developer” should now show in your ribbon.
Windows
• Go to FILE Ø OPTIONS, click on the “Customize Ribbon” button, and a dialogue box
will open.
• On the far upper right-hand part of the screen you will see “Customize Ribbon”. Just
below it you will see a pull-down menu: select “Main Tabs”, and in the dialogue box
below you should see a box for “Developer”. Check the box and click on the “OK”
button in the bottom right-hand corner of the dialogue box. You should now see
“Developer” in your ribbon.
Setup to record your first Macro
Now we are ready to record a macro. But before we do, I would suggest that you write down all of
the steps that you want to record, as well as the order that you want to record them in. For
example, I am going to record a macro that will “sign” my name to any document that I wish. So I
will list the events that I want to record:
1. Choose the font that I want. For this example I choose

Edwardian Script. It looks “Old

School” and like something we would use long ago.
Continued on page 4
_____________
1. Your ribbon is your “Microsoft Office Fluent user interface” that contains tabs and commands on your
screen.
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Macros: Clearing up the Mystery,
Part 2, continued
Continued from page 3

2. Choose the font size that I want. I choose 16 point because Edwardian Script font is small.
3. Type my name, “Brent N. Chadwick”.
4. Choose the usual font and size that I would normally use so that after I sign my name I can
continue to type in my document.
Keep in mind that everything that you do when you are recording gets recorded. That means
after hitting the record button you do not want to check your e-mail, Facebook accounts, Twitter,
or even scroll up and down in your document. If you were to do that while recording and looked at
the recorded code, there would a lot of extra gibberish, which is not a desirable thing.
Recording your first Macro
Macintosh
•

Click on the “Developer” tab. In the upper left-hand part of the “Ribbon” you should see
four icons: Editor, Macros, Record and Pause.

•

Click on the “Record” button, you will now see a dialogue box appear asking for you to
name your macro. I choose “mysignature”. In a macro name there can be no spaces.

•

Click the “Keyboard” icon to give your macro a keyboard Shortcut.

•

You will see a dialogue box open and next to “Press new keyboard shortcut:” a place
where you can type your shortcut. I choose “Control+Command+Option+S”. Hold down
the three function keys and press the “S” letter. Click on the “Assign” button to the right.
In the bottom left-hand corner you will see “Save changes in:” to choose where the
shortcut is to be saved. You can either choose to use the shortcut in the document you
are working, or if you choose “Normal.dotm” you can use it in all of your documents. For
this example I choose “Normal.dotm” because I may want to use it other documents.

•

Click on “OK”.

•

Click on the “Home” tab and follow the numbered steps above.

•

If you need to stop the recording but want to continue, use the “Pause” button.

•

After recording the steps above click on the “Stop” button.
Continued on page 5
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Macros: Clearing up the Mystery,
Part 2, continued
Continued from page 4

Windows
•

Click on the “Developer” tab. Just below the “Developer” “Ribbon” you should see
three icons: Visual Basic, Macros, Record Macro and Pause Recording.

•

Click on the “Record” button, you will now see a dialogue box appear asking for you
to name your macro. I choose “mysignature”. In a macro name there can be no
spaces.

•

Click the “Keyboard” icon to give your macro a keyboard Shortcut.

•

You will see a dialogue box open and a place where you can type your shortcut. I
choose “Alt+S”. Hold down the “Alt” function key and press the letter “S”. A little
lower down you will see “Save changes in:” to choose where the shortcut is to be
saved. You can either choose to use the shortcut in the document you are working, or
if you choose “Normal.dotm” you can use it in all of your documents. For this
example I choose “Normal.dotm” because I may want to use it other documents

•

In the lower left-hand corner click on “Assign”, and click on the “Close” button.

•

Click on the “Home“ tab and follow the numbered steps above.

•

If you need to stop the recording but want to continue, click on the “Developer”
button and use the “Pause Recording” button.

•

After recording the steps above click on the “Stop recording” button.

Now every time I want to “sign” my name to a document I just use the keyboard shortcut and this
is what I get- Brent N. Chadwick – just like “magic”.
This is a simple Macro to demonstrate the basics of how to set up and record a macro. You can
record most simple macros that genealogists might use this way. There are many more possible
uses for a macro that can speed up repetitive tasks. But now you have an idea how to record them
and assign a keyboard shortcut.
Brent Chadwick is a professional genealogist located in East Otis, Massachusetts. He loves developing
timesaving devices for genealogists to improve the family history research process. His website,
www.knoxtrailancestree.com includes many products that may be of use to the professional genealogist.
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Menger Hotel Information
This year, the Forensic Genealogy Institute is
moving to a brand new venue – the historic
Menger Hotel in San Antonio, Texas! This hotel,
the oldest continuously operating hotel west of the
Mississippi, is conveniently located next to the
historic Alamo and adjacent to the Riverwalk and
Rivercenter Mall, with numerous shopping and
dining options.
FGI attendees can stay at the Menger Hotel for the
discounted room rate of $135 per night (plus tax),
while availability remains. This price is for single
or double occupancy and rooms with 1 king-sized bed or 2 queens-sized beds are available. This
discount is available for the nights of March 9-12. Each guest room includes complimentary Wi-Fi
and valet parking.
Reservations can be made by calling the Menger Hotel directly at (800) 345-9285. Please mention
CAFG Forensic Genealogy Institute to receive the discounted rate. See the CAFG website for more
details at: http://www.forensicgenealogists.org/institute/hotel/

Members in the News
CAFG Member, Cathi Becker Wiest Desmarais, CG, was recently elected to a second term as
Vice-President of the Association of Professional Genealogists. Cathi is the owner and principle
researcher at Stone House Historical Research, and can be contacted through her website at:
www.StoneHouseResearch.com
Janice Sellers, will be presenting her lecture, “Get Me to the Church on Time: Finding Religious
Records” at the Southern California Genealogical Society Jamboree on June 26, 2016 in Burbank,
California. Janice also was featured in the Northwest Florida Daily News on October 24, 2015 after
she gave a talk to the local Family History Center on using newspapers in family history research.
Janice is the owner of Ancestral Discoveries and specializes in Jewish, African American,
newspaper and forensic genealogy.

*Certified Genealogist (CG) is a service mark (sm) of the Board for Certification of Genealogists®, conferred to associates who
consistently meet ethical and competency standards in accord with peer-reviewed evaluations every five years; the board name is
registered in the US Patent & Trademark Office.
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